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Changes to Input and Output



LS-DYNA Keyword Support

• PRIMER 21.0 keywords:

• LS-DYNA up to and including R14 fully supported.

• Some LS-DYNA R15.0 additions and modifications to commonly used keywords supported.

• Default output version remains R11.0 (later versions including R15.0 can be selected).



JT Reader



JT Reader

• The capability to read JT files has been reinstated in PRIMER 21.0

This work contains software that is proprietary and confidential to Siemens. © Siemens 2024



CAD/IGA Rendering Improvements



CAD/IGA rendering improvements

• Previously, the rendering of curves and surfaces 

was achieved by discretising them into a fixed 

number of segments. This led to excessive 

numbers of trias for small surfaces, which could 

slow down graphics, and low resolution of curved 

features for large surfaces.

• Now, this discretisation varies depending on a set 

of segment sizing and surface matching criteria. 

This improves resolution of curved features on 

large surfaces, while reducing trias in flat areas.



CAD/IGA rendering improvements

• The sizing criteria can be set via the Display → Options panel:

• Curve/Surf max seg/edge gives the maximum length of a 

segment or tria edge, used to render a surface;

• Curve/Surf min seg/edge gives the minimum length of a 

segment or tria edge;

• Max separation gives the maximum separation allowed 

between a segment/tria and the CAD surface.

• All options are factors of the overall model length: e.g. for a model 

that is ~1m long a value of 0.01 will yield a length of ~10mm

• All options can be saved as preferences.



CAD/IGA rendering improvements – additional improvements

• Previously, reading a STEP/IGES file could produce many errors in the dialogue box if 

surfaces failed to render.

• Now, these errors have been consolidated and a single error message is printed 

stating how many surfaces, out of the total number, failed to render.

• To make it easier to visualise which surfaces failed to render, PRIMER can now 

automatically highlight the trim curves of failed surfaces in a separate model.

• This option is controlled by a preference, 

primer*geometry_highlight_failed_surface_boundaries, which is off by 

default.



DUALCESE and COSIM Includes



*DUALCESE_<INCLUDE_>MODEL and *INCLUDE_COSIM improvements

• Previous versions of PRIMER would 

store the filenames specified by 

*DUALCESE_INCLUDE_MODEL, 

*DUALCESE_MODEL, and 

*INCLUDE_COSIM cards but would 

ignore the contents of those 

additional files.

• PRIMER 21.0 affords a similar 

treatment for these cards as for 

regular structural includes and 

ensures the contents of the additional 

files are also read.

• Include and Part Tree support have 

also been added.



*DEFINE_CURVE_FUNCTION



String parsing for *DEFINE_CURVE_FUNCTION

• In previous versions *DEFINE_CURVE_FUNCTION entries were treated simply as a string.

• In PRIMER 21.0 entries are parsed to determine type e.g. node, part, load-curve, etc.

• Cross references to *DEFINE_CURVE_FUNCTIONs are created so items cannot be accidentally deleted.

• External label changes of Node, Part, etc. updates the *DEFINE_CURVE_FUNCTION string.

• Check function reports unrecognised tags.

• Parameter usage for labels is supported, e.g. LC&CLAB, SENSOR(&SLAB).



Modified Includes and Missing Files in 
Model Build



• The following process describes writing modified includes 

and the meanings of the highlighting colours:

• Find modified red-lights modified include(s);

• The master file is always red-lit on assumption that 

include will be written to a modified name;

• Write the modified include to an incremented filename

Include is now grey lit;

Write to same name removes red-lighting;

• Write the master file removes grey-lighting to restore 

un-modified status.

Writing modified includes



Detection of missing files for model build (1)

• Model build tree red-lights 

components when file is missing.

• These components should not be 

selected for model build.

• Hover text gives full path filename.



Detection of missing files for model build (2)

• Model build template panel red-lights 

components when file is missing.

• Hover text gives full path filename.



*SET_PART_TREE in Treeview



*SET_PART_TREE in Treeview

• *SET_PART_TREE is a special type of set that can have:

• Parts (negative entries in the set);

• Child set part trees (sub-branches) (positive entries in the set).

• This keyword was previously supported, but from  PRIMER 21.0 the hierarchy is also 

available in the part tree treeview.



*SET_PART_TREE in Treeview

• Changes in the keyword editor are automatically reflected in the treeview and vice-versa.



Renumber Selection



Renumber Selection using “start at label”

• Label clashes can be resolved in any of the following ways using “start at”:

• Move all clashing (unselected) items to above highest label of type;

• Apply offset to shift clashing labels above the sequential target range;

• Relabel selected items to first free slot (won’t necessarily respect start label);

• Relabel selected items as a block to the first range that can accommodate them

(new PRIMER 21.0 option).



Renumber Selection using “offset label”

• Label clashes can be resolved in any of the following ways using “offset”:

• Apply offset after moving all clashing (unselected) items to above highest label of type;

• Offset selected items as a block to first found free space that can accommodate them

(new PRIMER 21.0 option).



NASTRAN Support



New and modified options for NASTRAN write

• New: Suppress elements for rigid parts

• New: Fix clashing nodal rigid bodies before export

• Tied contact to RBE3 is now on by default

• New: Poisson ratio supplied if uncalculated

• New: Zero length beam/vector “scaled” for NASTRAN 

compatibility

• New: MAT_169 (Arup Adhesive) converted to MAT_03 

parts



New NASTRAN write-out/reading options

• Translate matl with undef poisson ratio:

• Materials with no poisson's ratio are translated to MAT_01 with a user defined value for PR. If no value is 

given, default value of 0.001 is used.

• Scale Beam:

• Beams are scaled to a user defined value if you check the option ON.

• Scale Beam Orient Vector:

• Beam orientation vectors are scaled to a user defined value if you check the option ON.

• If the beam length is zero and the orientation vector is not set, it will be automatically created in the 

direction that is perpendicular to the beam axis with a unit magnitude.



New NASTRAN write-out/reading options

• If MAT_67 cards are present in the model and you write out the model in NASTRAN format, you 

will now be given options to write MAT_67 with stiffness values present in NASTRAN write out → 

properties panel & save it as a preference or abort the writing process. 

• NASTRAN's RBE2 can now be written and read in wide format in PRIMER correctly.

• PRIMER can now read in NASTRAN's PLOAD2 card. They are converted to LOAD_SHELL 

keywords inside PRIMER.

• MAT_169 into new MAT_03 parts by thickness:

• Option to correct the stiffness of parts using MAT_ARUP_ADHESIVE. MAT_ARUP_ADHESIVE can adjust 

the stiffness of elements using the BTHK parameter to account for adhesive being thicker in models 

than reality. But this stiffness correction is lost when the model is written out for NASTRAN. Now, we 

move bond elements into different parts with scaled stiffness depending on their thickness.



Translation of Rigid Parts to CONM2 + RBE2

• primer*nastran_write_suppress_rigid_elements: ON

• CONM2 created, elements suppressed for all rigid parts

• primer*nastran_write_rigid_element_limit: N

• Rigid bodies with >N elements, RBE2 written only to connected points

• N = 0, RBE2 written to all (external) nodes of rigid body

CONM2 + RBE2 
attached nodes

LS-DYNA Rigid body + Extra_nodes

N = 1 N = 0 

CONM2 + RBE2 
all rigid nodes



Include control for RBE3s generated from tied contacts

• RBE3s are created from DYNA tied contact

• A new preference controls the include file for such 

entities:

primer*nastran_write_contact_rbe3_placement

• The following options are possible:

• DNODE: use include of element of dependent node (default)

• INODE: use include of element to which node ties

• CONT: use include of contact
DNODE

INODE



Precision Improvements



Precision Improvements: Nodal coordinates

• PRIMER 21.0 now stores all nodal coordinates in 64 bit double precision floats:

• This change has improved the accuracy of internal Orient and Transform operations. 

• In addition where PRIMER is part of a workflow it will no longer truncate the precision of 

coordinates provided at more than 8 digits of precision.

• Memory use for a typical model has increased by typically 3% to 5%; speed is not affected.

Attribute Old 32 bit storage New 64 bit storage

Mantissa precision 7 reliable decimal digits
8th digit “noisy”

15 reliable decimal digits
16th digit “noisy”

Exponent range Roughly E+/-38 Roughly  E+/-308

Output precision 8 sig figs by default 16 wide fields typically give 12 or 13 sig figs plus exponent
20 wide fields default to 15 rounded sig figs plus exponent

Internal 
transformations

Used a mixture of double and 
single precision arithmetic

Now performed entirely in double precision



• Coordinate precision in the GUI is controllable, the default being to 

show 10 significant figures (easier for humans!).

• Coordinate output in the keyword file is separately controlled.

*NODE

$:   nid              cx              cy              cz

       7.6666666666666671.24401693585629.089316397477040

Precision Improvements: Nodal Coordinates



Precision Improvements: Clamp to zero

• “Clamp to zero” deals with residual errors after transformations.

Keyword Read model Write model Result

*INCLUDE_TRANSFORM
*NODE_TRANSFORM
*PART_MOVE

Orient to “as 
transformed” 
position

Inverse orient to 
“untransformed 
position”

Small differences at 
the 15th or 16th 
significant figure

• For non-zero values any differences at the 15th or 16th sig fig get rounded 

away when the value is written to a 16 wide field, typically at 12 or 13 sig 

figs precision. So output equals original input.

• However an initial value of 0.0 that goes through this process may end up 

as a small residual value, e.g. 1.0e-15, which both looks unwieldy and is a 

change to the input.

• “Clamp to zero: Trans Coord” clamps transformed nodal coordinates to zero 

if |coordinate | is <= clamp value.  Default value = 5e-15.



Precision Improvements: Rounding

• The IEEE 754 standard defines how values should be rounded. In all cases 

this is “round to nearest value” but this does not address the tied case 

exactly between upper and lower bounds.

• In this tied case the standard gives two options for decimal values, typical 

results shown in the table below:

• PRIMER defaults to “Tie away from zero” since it is more intuitive for decimal 

values, but this can be changed if compatibility with “Tie to even” is required.

Value Tie away from zero
(permitted for decimal values)

Tie to even
(default)

+2.5 +3.0 +2.0

+3.5 +4.0 +4.0

-2.5 -3.0 -2.0

-3.5 -4.0 -4.0



Precision Improvements: Cut section properties

PRIMER 20.0                                                 PRIMER 21.0
 

• The cut section property calculation was mathematically correct but numerically sensitive when the origin 

of the section was remote from the centre of the piece of structure being cut.  

• The doubly symmetric section above should have Ixx = Iyy and Ixy = 0.0 but there is a small error in the 

PRIMER 20.0 case on the left above.

• In PRIMER 21.0 the calculation is approximately 8 orders of magnitude more accurate.



Keyword Editor and Editing Panels



Keyword Editor

• Previously, in the Keyword editor panel the width of the fields were fixed.

• It was therefore difficult to view fields with long entries, e.g. in the “Incl” and “Suffices” columns. 

• Now columns can be resized by clicking and dragging the right edge of the column header.

• Additionally, double clicking resizes the column width to fit the longest entry in the column. 



Keyword Editor

• “Auto fit cols” - Resizes all the column widths to fit the longest entry in the respective column.

• “Reset cols” - Resets all the column widths to the default size.



Prevention of duplicate editing panels #1

• Historically PRIMER has allowed you to have multiple scalar editing panels open for the same 

item which has the potential to cause confusion:

First editing panel on Node #1

Changes made here and saved…

Second editing panel on Node #1

… will be overwritten if this panel is then 
closed and saved.



Prevention of duplicate editing panels #2

• The default behaviour is now that the second and subsequent editing panels opened on an 

item will be in read-only “browse” mode which will not modify the definition:

• This default can be changed in Options, Panel behaviour 

• It can also be controlled by preference   primer*permit_duplicate_edit:  true | false



Changes to User Interface



Initial View

• You can now control the initial view when PRIMER opens. By default, PRIMER opens with a plan 

view, +XY. If you wanted to change this to an elevation +XZ, for example, you can now change 

the default by setting the preference:

primer*initial_view_orientation: +XZ

Default +XY view                                                                                   +XZ view set via preference



Ambiguous Pick Behaviour

• When enabled, the ambiguous pick 

menu is displayed if multiple entities are 

close to the clicked location.

• From PRIMER 21.0 this is switched off by 

default, apart from for plies.

• The menu can be switched on with 

preference primer*query_ambiguous 

or via Options → Pick & Select opts → 

Ambiguous pick menu.



Object Menu Expansion Behaviour

• In previous versions, object menus were set to 

auto-undock by default. This behaviour has been 

modified.

• From PRIMER 21.0, expansion and undocking are 

turned OFF by default.

• This behaviour can be controlled using the 

preference primer*menu_expand or via Options 

→ Panel Behaviour → Expand menus



Screen Pick / Vis menu

• When entities are screen-picked, the Screen 

Pick menu is auto-populated and gives you 

further information on the entities picked. 

This menu also includes options to refine 

picking and can be explicitly invoked by 

clicking Vis in any object menu.

• The Vis (screen pick) menu has been 

redesigned to make various options more 

accessible and intuitive. Buttons have been 

reorganised, icons introduced, and hover 

text added.

PRIMER 20.0

PRIMER 21.0



Screen Pick / Vis menu

• By default, the updated screen pick 

menu is displayed as a docked 

menu as it was in previous versions 

but can, optionally, be made a 

floating menu by setting the 

preference 

primer*vis_menu_position 

and giving it the value "FLOATING"

Floating Vis menu



Swap Foreground and Background

• A quick way to change the foreground and background colour has been introduced by 

adding a Swap Fore/Back button under the Display menu. 

• This feature has also been added to the Programmable Shortcut Keys list so it can be 

assigned a shortcut key.

    Graphics with White Background           Display → Swap Fore/Back          Graphics with Black Background  



Controls for graphics text and labels

• Controls for the appearance of text and labels in the graphics window 

have been updated to be more consistent with the rest of the Oasys 

Suite. New options can be found under 

Display → Options → Text & Labels.

• Now, by default, text in the graphics window will scale with the 

window.

• Alternatively, a point size can be specified, and text size will remain 

fixed.

• Controls to toggle the label background on/off. Display for label 

background is set to ‘ON’ by default.



Label Background

• Labels now have a background to increase the legibility of the text.

• The background can be turned off in Display Options → Text & Labels → Label Background or by 

setting a preference: primer*label_background.



Additions to Quick Pick

• ICFD_PART and ICFD_PART_VOL are now 

available in Quick pick and for visual 

selection in object menus.



Favourite Tools & Keywords

• When selecting from existing Tools and Keywords 

buttons to add to your Favourites, the options are 

now displayed in a tree widget to provide a better 

representation of the existing structure and better 

support non-ASCII characters in button names.

• Additionally, the maximum number of buttons that 

can be added to your Favourite Tools or Keywords 

is increased to 100.



Per-Monitor DPI Awareness

(Windows platforms only)



Per-Monitor DPI Awareness

• Windows 10 allows monitors of different resolutions to be used on a single desktop. For example, 

when a high-resolution laptop is attached to a lower-resolution monitor, you will see something 

like this in Windows “Display Settings”:



Per-Monitor DPI Awareness

• When the monitors have very different Dots Per Inch (DPI) values, windows will look either “too 

big” or “too small” when moved to a different monitor unless the application adjusts its fonts 

and other scaling. This was a problem with Oasys Ltd software before Oasys Suite 21.0.

• From Oasys Suite 21.0 onwards, Oasys Ltd applications will detect when they are moved to a 

different monitor and will resize themselves and their contents to fit correctly. Specifically:

• The master application window will resize;

• Fonts will resize;

• Line widths and spacing in the user interface will resize.

• The appearance may not be identical, since fonts scale in integer steps of point size, but it 

should be close. Bear in mind that images are captured at the resolution of the monitor so 

consider this when creating images.



Data Plotting



Data plotting – Contour Ramp Options

• New contour ramp colour options 

have been added to the contour 

LEVELS panel in PRIMER 21.0

• There are currently 5 options:

• Default

• Viridis

• Plasma

• Magma

• Inferno

• The image on the right currently 

shows the default rainbow ramp



Data plotting – Contour Ramp Options

Viridis InfernoMagmaPlasma



Data plotting – Contour Level Options

• A new radio button for contour level 

options has been added to the 

contour LEVELS panel in PRIMER 21.0

• There are currently 2 options:

• Automatic levels (default)

• User-defined levels

• The image on the right currently 

shows the “Automatic levels” mode



Data plotting – Contour Level Options: Automatic levels

• This is the default option

• This is the original behaviour from 

PRIMER 20.0 and earlier

• Contour level values are uniformly 

distributed based on the 

maximum and minimum values 

specified in the relevant contour 

SETTINGS panels

• Number of contour levels can be 

modified by the #Levels slider



Data plotting – Contour Level Options: User-defined levels

• In this mode, users can modify the 

contour values manually:

• When the values are unordered, the “Sort 

levels” button is enabled and can be used 

to sort the values into ascending order;

• This mode is not available when the data 

component being contoured is integer 

data

• If a component has discrete data, this 

mode will only be available when discrete 

contouring is disabled

• Levels can be added/deleted with the 

popup menu from the value textboxes



HBM Trees

Image acknowledgements:

THUMS - Toyota Motor Corporation

GHBMC - Elemance



Supported GHBMC models – detailed 

• Tree files help position and prepare HBMs for LS-DYNA analysis.

• These are available for the most popular GHBMC models.

• Tree files are free to PRIMER users and 

available from your local Oasys distributor.

• Detailed occupants:

• F50-O v6.0.1

• F05-O v5.1/v6.0

• M50-O v5.1/v5.1.1/v6.0/v6.1

• M95-O v5.1/v6.0

• Detailed pedestrians

• F05-P v1.2/v5.3.4

• M50-P v1.6/v5.3.1/v5.3.4

• M95-P v1.2/v5.3.4

Image acknowledgements: Elemance, distributor of the GHBMC models https://www.oasys-software.com/dyna/models/hbm-trees/

https://www.oasys-software.com/dyna/models/hbm-trees/


Supported GHBMC models – simplified  

Image acknowledgements: Elemance, distributor of the GHBMC models https://www.oasys-software.com/dyna/models/hbm-trees/

• Simplified occupants:

• F50-OS v2.3.1

• F05-OS v2.3

• M50-OS v2.3

• M95-OS v2.3

• Simplified pedestrians:

• F05-PS v1.8/v5.3.4

• M50-PS v1.8/v5.3.4

• M95-PS v1.8/v5.3.4

• 3YO-PS v1.8

• 6YO-PS v1.8

• 10YO-P v1.8

https://www.oasys-software.com/dyna/models/hbm-trees/


Supported THUMS models

• Tree files are free to PRIMER users and available from your local Oasys distributor.

Image acknowledgements: THUMS| Toyota Motor Corporation https://www.oasys-software.com/dyna/models/hbm-trees/#thums

• Version 4 Pedestrians: 

• AF05-P v4.0.2

• AM50-P v4.0.2

• AM95-P v4.0.2

• 3YO/6YO/10YO v4.0

• Version 4/5/6/7 Occupants: 

• AF05-O v4.1/v5.0.3/v6.1/v7

• AM50-O v4.1/v5.0.3/v6.1/v7

• AM95-O v4.1/v5.0.3/v6.1/v7

• 3YO/6YO/10YO v4.0

https://www.oasys-software.com/dyna/models/hbm-trees/#thums


Supported THUMS models

• Tree files are free to PRIMER users and available from your local Oasys distributor.

• Seatback Reclined (25/35/45 Deg.): 

• AF05-O v7

• AM50-O v7

• AM95-O v7

Image acknowledgements: THUMS| Toyota Motor Corporation https://www.oasys-software.com/dyna/models/hbm-trees/#thums

• Others: 

• Elderly AF50/AM50 V4.0

• Whiplash F50/AM50 V4.0 

• Obese BMI35 V4.0

https://www.oasys-software.com/dyna/models/hbm-trees/#thums


HBM Visualisation Entities

Image Acknowledgements

GHBMC - Elemance



HBM Visualisation entities file for D3PLOT

• It is now possible to view Human Body Model (HBM) visualisation entities, created by 

the HBM Visualisation table, in a D3PLOT session using a “D3PLOT groups file” (*.vis).

• A model specific “D3PLOT groups file” can be created from the Visualisation table in 

PRIMER, using the newly added buttons under the ”Create D3PLOT groups file” label.



HBM Visualisation entities file for D3PLOT

• The radio buttons provide an option to choose the type of HBM visualisation entities, that you 

want to view in D3PLOT.

• Assembly entities: Creates a D3PLOT groups file with only those entities that are viewed in 

an “Assembly view”.

• Anatomy entities: Creates a D3PLOT groups file with only those entities that are viewed in 

an “Anatomy view”.

• Assembly and Anatomy entities: Creates a D3PLOT groups file with all the entities that are 

viewed in both the “Assembly” and  “Anatomy” views.

• “Apply” will create a D3PLOT groups file with a filename (*.vis) specified in the adjacent textbox.

• This groups file can be loaded into a D3PLOT session on the LS-DYNA results of the same 

model.



Create HBM Visualisation entities file for D3PLOT 
1

2
3

4

5. Create HBM visual entities

6. Select the type of entities 
to be written out into the 
groups file

7. Give a filename. (A default 
filename is always shown, you 
can change if you wish to)

8. Apply to create D3PLOT 
groups file

9. Check the confirmation message in 
the Dialogue box



View HBM Visualisation entities in D3PLOT

2

3
4. Select the *.vis file of the model

5. Apply will load the HBM visual 
entities from the file and applies 
them on the model in the 
graphics area. 

1. Load the LS-DYNA results (*.ptf/d3plot file) of the 
model into D3PLOT, for which you have the *.vis file.



View HBM Visualisation entities in D3PLOT

• In Groups menu, you can see the list of HBM entities and perform various operations 

like Only, Sketch etc.

6

7. Select the Group 
name from object menu



HBM Tool Updates



New Dialogue command to write DAF

• A new dialogue command WRITE_DUMMY_ANGLE is added to allow you to write out 

a Dummy Angles File when working with Dummies/HBMs in Command-line mode.

• PRIMER writes out a Dummy Angles File for the selected Dummy, when you enter the 

following command in the dialogue box:

• DUMMY >>> WRITE_DUMMY_ANGLE <filename>



Positioning of Assemblies with Multiple parents

• In previous version of PRIMER, Dummy/HBM 

assemblies can have multiple parents. The 

extra connections between assemblies is 

achieved with PIN/LINE/HINGE. This creates 

circular connections amongst assemblies in a 

dummy construct. 

• From PRIMER 21.0, it is possible to use the 

Rotate Angles positioning method to 

position such assemblies. Image Acknowledgement: THUMS – Toyota Motor Corporation 



Positioning of Assemblies with Multiple parents

• (R): The indicated assembly is the Root Assembly.

• (E): One or more child/grandchild assemblies of the indicated assembly have Mechanism style 

connections.

• (M): The indicated assembly has multiple parent assemblies and therefore connected with the parents 

in mechanism style connections.

• For Circular connections, the feature of dragging using a particular mouse button to rotate 

about a particular axis is not applicable. Instead, if you drag an assembly with any mouse 

button, PRIMER rotates that assembly about any axis as per your mouse movement.

• The angle rows of all the assemblies with circular connections are 

displayed with a grey background in the “Rotate angles” panel.

• In the Assembly list, the indications (R), (E) and (M) against the 

assembly names indicate the following:



Cut Sections



Cut sections improvements

• In PRIMER 20.0 the numbers of parallel cut planes in 

positive and negative directions for uniform (non-custom) 

spacing were concatenated into one text box.

• In PRIMER 21.0 there are separate text boxes for both 

numbers of planes.

• In previous versions, cut section custom spacing positions 

were sorted immediately after editing. This is unintuitive 

when editing several positions in a row.

• In PRIMER 21.0 positions will remain where they are after 

editing even if they are then no longer in ascending order.

• The new Sort positions button can then be used to sort 

the positions into ascending order.



New cut section properties 

• Two new properties have been added to the ‘Cut Section Properties’ panel:

• Plastic equal area axes (Xe_g, Ye_g, Ze_g);

• Fully plastic equal force axes (Xf_g, Yf_g, Zf_g).

• Changed the labels of the centroid global coordinates from (Xg, Yg, Zg) to (Xc_g, Yc_g, Zc_g)



Battery Setup Tool



Battery Setup Tool

• The battery setup tool is a new feature in PRIMER 21.0 which is accessible through the ‘Batteries’ 

button from the Tools panel.

• It can be used to set up a pouch battery structure from scratch and combine it with relevant 

*EM_RANDLES keywords to model Randles circuits within the battery cell. 

• The workflow is split into five steps as follows:

1. Selecting the 
modelling scale

2. Creating the 
layers structure

3. Creating the 
tabs structure

4. Defining the 
Randles parameters

5. Activating / Creating 
analysis keywords

➢ Micro scale
➢ Meso scale
➢ Macro scale
➢ Meshless scale

➢ Structural analysis
➢ Thermal analysis
➢ EM analysis



Battery Setup Tool

1. Geometry & Scale:

• The tool supports all 4 possible scales for 

modelling a battery cell using the 

*EM_RANDLES LS-DYNA keyword:

• Micro scale: uses *EM_RANDLES_SOLID

• Meso scale: uses *EM_RANDLES_TSHELL

• Macro scale: uses *EM_RANDLES_BATMAC

• Meshless scale: uses *EM_RANDLES_MESHLESS 

and could be connected to a Macro scale 

structure. Otherwise, steps 2 and 3 will be 

skipped and no physical structure will be 

created.  



Battery Setup Tool

2. Layers structure:

• Once the modeling scale is selected, the structure of the 

battery internal layers can be created by providing the 

dimensions, origin, meshing density, how many unit cell 

repetitions are needed, the material and thermal material 

information, thickness, and the initial conductivity for the two 

current collectors. 

• For the Micro and Meso scales, the material and thickness 

properties of each layer must be provided separately, while 

for the Macro and Meshless (connected to Macro structure) 

scales, these properties must be provided for the unit cell as a 

whole.



Battery Setup Tool

2. Layers structure:

• The type and number of parts that will be created per unit cell will depend on the selected scale.

• PRIMER will also automatically associate the generated parts to *EM_MAT cards to define the 

electromagnetic properties of corresponding materials and set the initial potential of current collectors.  

NCC (solid *PART)

PCC (solid *PART)

Anode (solid *PART)

Cathode (solid *PART)

Separator (solid *PART)
 

Unit cell
(*PART_COMPOSITE_TSHELL) Unit cell (solid *PART)

Micro Meso Macro

*EM_MAT_001 for each layer type *EM_MAT_006 for the unit cell

Can be composed of as 
many layers as needed



Battery Setup Tool

2. Layers structure:

• Multiple repetitions of the unit cell can be created for any scale.

Unit cell Unit cell

Separation

Separation



Battery Setup Tool

3. Tabs structure:

• Once the layers structure is created, the structure of the positive and 

negative tabs for each unit cell can be created by providing the 

dimensions, meshing density, the material and thermal material 

information.

• Tabs are always modeled as solid *PARTs for all scales.

• Four different configurations of tab positioning relative to the layer unit 

cell are available.
+ tab- tab- tab+ tab + tab

- tab

- tab

+ tab

Same side A Same side B Counter A Counter B 



Battery Setup Tool

3. Tabs structure:

• Each tab structural material will automatically be associated to an *EM_MAT_001 

card to define its electromagnetic properties.

• PRIMER can automatically connect the tabs to the layers structurally by generating 

*CONSTRAINED_NODAL_RIGID_BODY cards at each tab-layer connection that 

include all nodes on the common tab-layer surface.   

            

• PRIMER can also automatically connect the tabs to the layers electrically by 

generating *EM_ISOPOTENTIAL cards at each tab-layer connection by constraining 

overlapping nodes to have the same scalar potential value.                             

• An *EM_ISOPOTENTIAL card can also be generated for each tab to include nodes at 

the free surface (not connected to the cell). These could then be easily used to 

connect the different tabs using *EM_ISOPOTENTIAL_CONNECT cards. 



Battery Setup Tool

4. Randles parameters:

• Once the tabs structure is created, the Randles parameters from the 

relevant *EM_RANDLES keyword will need to be defined.

•  The layers parts (CPPPART, CCNPART, SEPPART, PELPART, NELPART) 

from card 1 of  *EM_RANDLES_SOLID and the part set (PSID) from card 

1 in *EM_RANDLES_TSHELL and *EM_RANDLES_BATMAC will 

automatically be referenced by PRIMER based on what has been 

generated at the '2. Layers Structure’ stage. 

• If in 'Meshless connected to Macro structure' mode, an extra 

*EM_ISOPOTENTIAL_CONNECT card with CONTYPE = 5 will be created 

connecting the Randles circuit to the cell layers nodes overlapping with 

the tabs. 



Battery Setup Tool

5. Analysis:

• The final step is to activate or create relevant analysis keywords by 

turning on the tick boxes next to the desired keywords and defining 

one or two fields. Once "Apply" is clicked, the selected keywords will be 

activated/created and can then be fully edited by clicking on the 

associated "Edit" button which will open up the corresponding modify 

panel.



Battery Setup Tool

Saving and restoring data:

• The data from all 5 steps can be exported to a csv file using the “Write 

CSV” button in the ‘5. Analysis’ panel, and imported back into a future 

session using the “Read CSV” button in the ‘1. Geometry & Scale’ panel.



Battery Setup Tool

Extra steps and post-processing:

• Once all 5 steps are completed, the tool can be closed. It might be necessary to connect the different unit cells (if multiple 

unit cells have been generated) and/or the battery cell to any external circuits, by using *EM_ISOPOTENTIAL_CONNECT of 

resistance type for example, as an additional step. It might also be required to activate extra analysis keywords not listed in 

the final panel of the tool, after which the model should be ready to submit to LS-DYNA. 

• An example of D3PLOT results for a Macro scale battery model generated by the tool is shown below. 



Spotweld Remesh Improvements



Skip preserving elements around a hole

• Previously, PRIMER would throw an error when attempting to preserve elements around a hole 

if it was positioned too close to spot welds.

• Now the elements around the hole are not preserved if they are close to spotwelds, such as 

those shown in the images below.



Improved handling of meshing errors

• Previously, spot weld remeshing would 

terminate if the weld is close to a feature 

line or free edge, leading to subsequent 

problems.

• A check has now been added to handle 

such meshing errors.

• PRIMER will skip the creation and 

remeshing of such spot welds and 

continue with the other selected spot 

welds.

Feature line



HAZ Elements preserved if not selected

• In PRIMER 21.0 Heat Affected Zone (HAZ) rings around spot welds are preserved if they are not selected for 

remeshing. 

• For example, the ring around CONX16 is now preserved if only connections CONX15 and CONX17 are 

selected for remeshing.



Adding nodes around spotwelds

• This feature was added in PRIMER 20.0 and has been improved in PRIMER 21.0, 

including making it significantly faster.



Adding nodes around spotwelds: Second feature line angle

• The Second feature line angle input 

should be greater than or equal to the 

Remesh feature line angle and less than 

HAZ mesh reconstruct feature line.

• PRIMER 21.0 has been made more 

robust to incorrect user inputs for the 

Second feature line angle.



Adding nodes around spotwelds: skipping connections

• Based on input parameters, adding nodes around spotwelds can now be skipped



Spotweld remeshing: Speed and efficiency improvements

• In PRIMER 21.0 significant improvements have been made to the speed of preserving elements 

around a hole, and now the entire process takes only a few seconds.

• All the elements around a hole are identified before remeshing, instead of checking each 

remesh shell individually for its position relative to the hole.

• In PRIMER 21.0, the mesh reconstruction stage has been made approximately 10 times faster 

than in previous versions.

• In PRIMER 21.0, a complete spot weld remeshing, including mesh reconstruction for a typical 

BIW, is now 3-4 times faster than in PRIMER 19.0 and 20.0.

• In PRIMER 21.0 spotweld remeshing using the "Always Align Flat Edge" option is more robust.

• An upgrade to the meshing engine has been made:

• Negative area shells are no longer created during spot weld remeshing. 



Solid Split Tool



Solid Split Tool – New split method

• A new solid split type “Split and propagate” has been 

added under Mesh tools → Split → Solid.

• This splits solids from the selected face and propagates 

the split through the solids.

• Three types of split are available:

• Split both axes

• Split with one axis

• Split direction normal to the selected face

• Selecting a face displays a preview of the split.

• The Align selected feature aligns the selected solids.

• Grow out face can be used to select all the elements on a 

surface (like the propagate feature in the Coat menu).



Solid Split Tool – New split method

Click on a face of a solid element
(example using 'Split both axes' 

option)

Preview the split Press ‘Apply’ to split



Seatbelts Enhancements



Seatbelt enhancements – Explicitly meshed pelvis slipring panel

• The Explicitly meshed pelvis slipring panel gives you the ability to:

• Quickly modify the initial path of the belt to ensure it fits within the slot of the pelvis slipring.

• Automatically reposition the explicitly meshed pelvis slipring to an accurate location during 

the fitting procedure.

• Create X-Sections around the pelvis buckle. 



Seatbelt enhancements – Adjust pelvis slipring initial path

• The ‘Adjust’ button in the bottom section of this 

panel can be used to automatically adjust the 

initial path of the belt to fit within the slot of the 

pelvis slipring. This will create two base points at 

each end of the slot and adjust all twist handles in 

the correct configuration. 

• All that is required is the information in the panel 

and to add a single base point near the top of the 

slipring (avoid creating more than one point near 

the slipring area) and then press the ‘Adjust’ 

button.



Seatbelt enhancements – Adjust pelvis slipring initial path

• The below example shows how the ‘Adjust’ button affects the initial belt path at the 

pelvis slipring.

‘Adjust’



Seatbelt enhancements – Explicitly meshed pelvis slipring

• This panel gives you the option to automatically move 

the pelvis buckle and slipring during the fitting 

process.

• You can select if the pelvis buckle should move in the 

forward/backwards, sideways direction or both 

simultaneously. 

• Only possible if all required fields are provided.

• The ‘Update freq.’ field controls how often the slipring 

is moved during fitting, and it is automatically set to 3.



Seatbelt enhancements – Explicitly meshed pelvis slipring
Sideways rotationForward\Backwards rotation

Forward\Backwards rotation rotates the whole stalk 

+ buckle (black) around a pivot point (red)

Sideways rotation rotates part of the stalk + buckle 

(black) towards the dummy until contact is made 



Seatbelt enhancements – Explicitly meshed pelvis slipring

Original buckle position: In the fitting process, the pelvis slipring shifts forwards to maintain the belt 

in the optimal position within the slot and moves sideways to establish 

contact with the dummy. Rotated position:



Seatbelt enhancements – Improving shoulder slipring rotation

• The number of belt fitting iterations between slipring  

rotations. A lower value gives a sturdier slipring rotation 

process, as it rotates more often, but takes longer to fit.

• The sensitivity setting dictates the reactivity of the 

slipring’s rotation. A sensitivity level of 10 ensures 

uninterrupted slipring motion, making it ideal for remote 

starting points. At lower sensitivity, the pulling of the 

slipring will automatically stop and restart depending on 

the position of the belt in the slipring slot, improving the 

fitting speed. 

• Initial belt path points around sliprings can now update 

coordinates after the belt path was accepted in the main 

panel. Therefore, initial path points can remain 

positioned within slipring slots after sliprings are rotated.



Seatbelt enhancements – User Interface improvements

• Removed the ‘Accept’ button from the ‘Explicit 

slipring’ panel and used the generic ‘Accept’ 

button from the main ‘Fit’ panel to save any 

updates from the ‘Explicit slipring’ panel.

• Deactivated the ‘Adjust’ button when clicked to 

indicate that it can only be used once. It will get 

reactivated if ‘Undo’ is clicked. 



Seatbelt enhancements – User Interface improvements

• Expanded the list of editable points 

in the 'Define path' panel (from 10 

to 19 points) to make it easier for 

the user to visualise and edit the 

data. 



Seatbelt enhancements – Cross Section for sliprings

• Added an option to create *DATABASE_CROSS_SECTION for explicit slipring, accessible 

from Fit → Explicit slipring panel. 



Seatbelt enhancements – Cross Section title & auto-refit 

• Additional prefix text and auto-refit title update can be accessed from 

Fit → X-Section.

• You can now choose to have additional prefix text for the title of 

*DATABASE_CROSS_SECTIONs created on seatbelts. Options are:

• None: No prefix text; 

• Automatic: Prefix text based on ISO standard (default);

• Custom: User-defined prefix text.

• When doing a belt Auto-refit, the title of the existing X-Sections can 

now be reused. Options are:

• Update default: Replace default part of the title keeping prefix text (default);

• Replace old: Replace old title with new default title;

• Keep old: reuse the old titles.



Seatbelt enhancements – Sticky points 

• If sliprings are not in the correct position, fitting the belt 

through a meshed slipring can lead the belt to drifting 

sideways and curl up against the side of the slot. 

• To avoid this, central path points can now ‘stick’ when they 

make contact with the structure. This allows the outer edges 

of the belt to fit correctly while the belt’s central path stays 

close to the initial contact point.

• The #Sticky pts value is the number of points along the centre 

of the belt, in between the current and next path points, that 

will stick to the structure. 



Seatbelt enhancements – Mesh Density new Custom mode

• Added a new 'Custom' mode for the seatbelt 

mesh density in the ‘Fitting options’ panel 

that gets automatically selected if the related 

properties (Max curve angle, belt length and 

#rows) do not match any of the available 

modes, and if they do match a specific mode 

this will also be automatically selected. 



Crash Test Setup Enhancements 



Crash Test Setup – Barrier Positioning Nodes

• Added a new barrier setting component in the 

‘Check Nodes’ window that offers two methods 

for automatically configuring the positioning 

nodes on the barrier as follows:

• If the “Existing” option is selected, the script will 

find the corner nodes at the lowest edge of the 

barrier front face (old method);

• If the “New Nodes” option is selected, the script will 

automatically create new nodes at the 

intersections of the lower front edge and lower 

side edges. This can be useful for barrier models 

with curved lower corners providing more accurate 

positioning results. 



Crash Test Setup – Barrier Positioning Nodes

• The mode selected in the ‘Check Nodes’ window can be saved at file scope as part of the Barrier 

settings.

• Both methods for automatically configuring the positioning nodes are supported in batch 

mode.

• The “New Nodes” option will create nodes at the first available labels, and these will be written 

to the barrier include file in the output model. There is no need to save these nodes for use in a 

new session as they will automatically be created if the mode is saved to “New Nodes” in the 

imported barrier settings. 



Crash Test Setup – Impact angle option

• New impact angle option has 

been added for the RCAR Low-

Speed (Front) Case to allow the 

user to position the barrier along 

the z-axis.



Pedestrian Markup Enhancements



Pedestrian Markup Tool – New protocol support

• Support has been added for the GB 24550 202X 

markup protocol:

• Selectable from the protocol list and command line 

options;

• Windscreen zone can be calculated with or without 

an obscuration part;

• If no obscuration part is provided, a pseudo-

obscuration width can be specified to emulate the 

existence of an obscuration part.



HIC Area Calculator



HIC Area Calculator

• Support has been added for UN R127.03, specifically the definition of the windscreen test zone.

• Windscreen test points are identified using the point name prefix ‘W’ or ‘B’. 

• Any input points that have names beginning with ‘W’ or ‘B’ will be used to defined a separate 

HIC zone when selecting the GTR / R127.03 regulation.

Windscreen 
Zone

Bonnet 
Zone



HIC Area Calculator

• The GTR/R127.03 results table includes new rows for the windscreen and bonnet (child and 

adult combined).

• Additional hover text has also been added to for the combined row, documenting exactly how 

the calculator arrives at it’s combined HIC area %.

Hover text



HIC Area Calculator

• Following the addition of the windscreen zone, it is now 

possible to input three different user defined perimeters: 

Bonnet, Windscreen and NCAP.

• Bonnet and Windscreen perimeters are used to define their 

respective test zones as used by the GTR/R127.03 regulation. 

• NCAP is not used any regulation output but does define the 

area considered when contouring HIC (from the Analysis 

tab), while selecting the NCAP regulations.

• Support for user input WAL (e.g. child WAL to distinguish 

child and adult zones) has been improved and is now 

more robust than previous versions. User 
Bonnet 

Perimeter

User Child 
WAL

Adult Zone

Child Zone

Windscreen Zone



HIC Area Calculator

• New functionality has been added to the ‘Points’ 

tab. Users can now:

• Query Point Data – by selecting a point from the 

screen, a pop-up menu will display the respective 

input data.

• Open Directories – by selecting a point from the 

screen, the tool will open a file browser window for 

the directory belonging to the point (only possible 

when a file path is included in point input data).



Closures Setup Tool 



Closures Setup Tool

• The closures setup tool is a new feature in PRIMER 21.0 which is accessible through the 

JavaScript menu.

• The intended application of the tool is for vehicle closures (e.g. bonnets, doors, tailgates).

• The tool helps setup a model so that the position of a closure include file can be controlled by a 

single *PARAMETER.

• This removes the need to maintain several models of the same closure in different positions 

and allows for more accurate positioning.

• The tool supports two types of hinges:

• Simple hinge;

• Four bar link.



Closures Setup Tool

• For example, the position of the bonnet 

or door include file can be changed by 

modifying a single *PARAMETER. 



Python



New Python API

• The new Python API will allow you to do most things you can do from the JS API.

• Advantage: the Python scripts run outside the programs: from the same script it is 

possible to speak to PRIMER, D3PLOT, T/HIS and REPORTER, and to any other software 

that has a Python API. It also allows importing any Python module into the script.

• Install the Python packages:

• https://pypi.org/project/Oasys.PRIMER/

• https://pypi.org/project/Oasys.D3PLOT/

• https://pypi.org/project/Oasys.THIS/

• https://pypi.org/project/Oasys.REPORTER/

• There is comprehensive Python API documentation to help you start scripting.

https://pypi.org/project/Oasys.PRIMER/
https://pypi.org/project/Oasys.D3PLOT/
https://pypi.org/project/Oasys.THIS/
https://pypi.org/project/Oasys.REPORTER/
https://help.oasys-software.com/articles/?readerUiPreview=1#!py_api-21-0/title


JavaScript API



JavaScript API: Behaviour of scripts using windows

• The way that scripts that use windows/GUIs are run has changed in version 21.

• All programs that have a graphical user interface (GUI) use an “event loop” to process any 

mouse/keyboard events.

PRIMER has a main “event loop” to process all of the program’s events.

• In version 20 and before, if a script created and showed a window, PRIMER would start a new 

“event loop” to manage and process that JavaScript window.

• The script would not return from the window Show() call until the window was hidden/closed.

i.e. showing the window would “block” execution of the script until the window was closed.

• When the window is closed, the script continues.

• When execution reaches the end of the script, the script is terminated.



JavaScript API: Behaviour of scripts using windows

• For example, in version 20 and earlier, in the following script, “Hello, world!” will not be printed 

until the window is closed because the call to w.Show() will not return until the window is closed.

// Create a window with a widget
var w = new Window("Test", 0.5, 0.6, 0.5, 0.6);
var l = new Widget(w, Widget.LABEL, 0, 50, 0, 6, "Press X to close the window");

// Show the window and start event loop
w.Show();

// Print message
Message("Hello, world!");

• When the window is closed the message is printed and the script will then terminate as 

execution has reached the end of the script.



JavaScript API: Behaviour of scripts using windows

• In version 21 the behaviour has changed.

• If a script creates and shows a window, PRIMER will *not* start a new “event loop” to manage 

and process that JavaScript window.

• The window will now be processed from the main “event loop” in PRIMER.

• The script now returns from the window Show() as soon as the window is shown, and execution 

of the script continues.

i.e. showing the window no longer “blocks” execution of the script until the window is closed.

• When execution reaches the end of the script, the script is *not* terminated.

• The script continues running “in the background” as the script has shown a window.



JavaScript API: Behaviour of scripts using windows

• For example, in version 21, in the following script “Hello, world!” will be printed immediately 

after the window is shown, because the call to w.Show() returns after the window is shown.

// Create a window with a widget
var w = new Window("Test", 0.5, 0.6, 0.5, 0.6);
var l = new Widget(w, Widget.LABEL, 0, 50, 0, 6, "Press X to close the window");

// Show the window
w.Show();

// Print message
Message("Hello, world!");

• When the message is printed, the script will *not* terminate when execution reaches the end 

of the script. The script will continue to run “in the background”



JavaScript API: Behaviour of scripts using windows

• If a script that shows windows continues running “in the background”, and does not terminate 

when execution reaches the end of the script, how/when does the script terminate?

• A script that uses windows *must* now call Exit to terminate the script.

// Create a window with a widget
var w = new Window("Test", 0.5, 0.6, 0.5, 0.6);
var l = new Widget(w, Widget.LABEL, 0, 50, 0, 6, "Press X to close the window");

// Exit when window closed
w.onClose = Exit;

// Show the window
w.Show();

// Print message
Message("Hello, world!");



JavaScript API: Behaviour of scripts using windows

• To find what scripts are currently running 

there is a new “Running” tool in the JavaScript 

window.

• Any scripts that are currently running will be 

shown and can be terminated if required.



JavaScript API: Behaviour of scripts using windows

• Why has this change been required?

• JavaScript is used extensively by clients to customize PRIMER and create their own workflows.

• It is also used by us to develop core tools/functionality in PRIMER.

• When multiple scripts are running at the same time, the way this was implemented in version 

20 and before was causing issues.

• Scripts had to be closed/terminated in the reverse order to which they were started.



JavaScript API: Behaviour of scripts using windows

• In version 20 and before, every time a script with a 

GUI is used, an “event loop” is created to process 

the script. Every “event loop” that is created is a 

“child” of the previous event loop.

• For example, the diagram on the right visualises the 

event loops in version 20, if script “A” and script “B” 

are both started.

• If the script “A” is closed, script “B” must also be 

closed as the “event loop” for script “A” is 

terminated, and the “event loop” for script “B” then 

has no “parent”.

Main event loop.
Process core events

Event loop for script “A”

Event loop for script “B”



JavaScript API: Behaviour of scripts using windows

• In version 21 we no longer create an “event loop” 

to process each script. Calling Window Show() 

returns instead of “blocking”

• The main “event loop” processes everything.

• For example, the diagram on the right visualises 

the event loop if script “A” and script “B” are both 

started.

• If the script “A” is closed, script “B” can continue 

to run as the “events” for it are all processed in 

the main event loop.

Main event loop.
Process core events

Process events for
script A

Process events for
script B



JavaScript API: Cross section

• New member function added: CrossSection.Autosize(). This function autosizes the 

*DATABASE_CROSS_SECTION such that it cuts all elements on the plane.

• New class function added: CrossSection.CreateAlongFeatureLine(). This function creates a series 

of *DATABASE_CROSS_SECTIONs along a free edge or feature line, starting at a specified node. 

The function also offers options to autosize the cross sections created.

• The constructor’s arguments have been deprecated. The new argument list consists of the 

model and cross section type (as before), and a third argument in the form of an object. The 

properties of this object argument can define the old arguments, as well as some new optional 

properties to control autosizing for _PLANE cross sections



JavaScript API: Workflows

• An extra optional argument has been added to Workflow.NumberOfModels().

• If defined it returns the number of models that have data for the specified workflow.

• If not defined it works as before where it returns the number of models that have data for 

the workflow selected by the user in the workflows menu.

• An extra optional argument has been added to Workflow.ModelIdFromIndex().

• If defined it looks through the list of models that have data for the named workflow and 

returns the model id of the model at the specified index in the list.

• If not defined it works as before where it returns the model id of the model at the specified 

index in the list of models that have data for the workflow selected by the user.



JavaScript API: Workflows

• New methods added to the Workflow class:

• Refresh() – scans for fresh workflow data;

• ModelUserDataProgramFromIndex() – Returns the name of the program that the user data 

was written from;

• ModelUserDataVersionFromIndex() – Returns the version of the program that the user data 

was written from;

• ModelUserDataBuildFromIndex() – Returns the build number of the program that the user 

data was written from.



Other JavaScript API changes

• An onHide event has been added to the Window class.

• Added new JS-API class for:

• *FREQUENCY_DOMAIN_RANDOM_VIBRATION;

• *DAMPING_FREQUENCY_RANGE;

• *DAMPING_PART_MASS;

• *DAMPING_PART_STIFFNESS;

• *DAMPING_RELATIVE.

• Added object types for:

• *DAMPING_MODAL;

• *DAMPING_STRUCTURAL.



Workflows
Workflows User Data

Automotive Assessments

Energy Check

Entities of Interest

Seismic Workflows

Defined and Undefined Workflows

Virtual Testing



Workflows User Data

• We have made it easier for you to save Workflows user data to be re-used by multiple models and LS-DYNA runs.

• In Oasys 20, the JSON user data file written by a workflow tool had to be saved in the same folder as the model/results. 

This meant that if you had multiple variations of a model, you had to have copies of the same JSON file in each 

model/results folder, which was time consuming if edits needed to be made to the data.

• In Oasys 21, JSON user data can now also be saved in the parent folders of models, meaning the same data can be used 

for multiple models. The model folder is searched first, and then parent and grandparent folders are searched for valid 

JSON files. Preference oasys*workflow_max_upward_folder_search_depth can be set to control the number of parent 

folders that are searched. The default is 4.

- folder 1
  |- user_data.json
  |
  |- folder 2
  |    |- model1.key
  |    |- user_data.json
  |
  |- folder 3
  |    |- model2.key
  |    
  |- folder 4
  |    |- model3.key

In this folder structure [right], the user_data.json file in folder 1 will be 

used for the models in folder 3 and folder 4, and the user_data.json file in 

folder 2 will be used for the model in folder 2:



Workflows User Data

• The scan will also look for user data in a folder named ‘workflow_user_data’ in the model folder and its parent folders.

• For example, in the folder structure below, the user_data.json file in folder 1/workflow_user_data will be used for the 

models in folder 3 and folder 4, and the user_data.json file in folder 2 will be used for the model in folder 2:

- folder 1
     |- workflow_user_data
  |       | - user_data.json
  |
  |- folder 2
  |    |- model1.key
  |    |- user_data.json
  |
  |- folder 3
  |    |- model2.key
  |    
  |- folder 4
  |    |- model3.key

• The name of the folder to search can be changed by setting the preference oasys*workflow_user_data_directory_name 



Automotive Assessments

In Oasys 21 the assessment 

values and scores are now 

presented in a table making 

it easier to view the results



Far Side + VTC crash test 

• New Far Side + VTC crash test has been added in the Automotive Assessments workflow to 

support Virtual Testing. 

• Includes support for all 115 channels (Occupants + Structures) required for the Euro NCAP 

Virtual Far Side Simulation & Assessment Protocol

https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf


Improved entity selection for multiple parts

• To facilitate multiple PARTs selection, new 

options have been added in the Automotive 

Assessments entity selection popup:

1. Select by PART

2. Select by SET_PART

3. Select by INCLUDE 

• In the Far Side + VTC crash test, these options 

are useful for selecting multiple PARTs for 

structural channels like Kinetic Energy, Internal 

Energy, and Hourglass Energy, for Airbag, 

Centre Console, Driver Seat and Dummy.



Updated support for different occupant versions 

• We now support the DYNAmore/PDB WorldSID 50M occupant in versions 4.0, 6.0, 7.6 and 8.0 for left-hand 

and right-hand drive. 

• We have reviewed and corrected various entity IDs and history titles in occupant JSON files that are 

supported in Automotive Assessments workflow. The list of occupant JSON files and corresponding manual 

referenced for checking are listed in this table.

https://help.oasys-software.com/articles/workflows-21-1/automotive-assessments-primer/a/supported_dummies


Euro NCAP Virtual Far Side Validation Criterion 2

• Automotive Assessments can be used to 
check Validation Criterion 2 manually, 
according to Section 6.3 of the Euro NCAP 
Virtual Far Side Simulation & Assessment 
Protocol.

• Validation Criterion 2 check can also be 
automated using Euro NCAP Virtual Far 
Side 2024 VC2 (Assessment Criteria) 
REPORTER template .

https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf


New Protocols

• In Oasys 21.1, the following new protocols have been added to the Automotive Assessments 

workflow. Each of these represents a different loadcase required as part of the C-NCAP 

Management Regulation (2024 Edition).

Crash Test Regulation Version Description

Far Side + VTC C-NCAP 2024 (SID2-SBLD) • Front passenger side impact, assessing driver (Far Side 
Occupant) injury. 

• Injury scoring according to Chapter III section 1.2.1.5.3 of  
C-NCAP Management Regulation (2024 Edition) and 
Virtual Testing according to Appendix H.1.2.1.3.

Far Side + VTC C-NCAP 2024 (WSID)

Far Side Pole C-NCAP 2024 (ES-2re+WSID) • Front passenger side impact, assessing driver (Far Side 
Occupant) injury according to Appendix H.1.2.2.2. 

• Injury scoring based on Chapter III section 1.2.1.5.4 of  
C-NCAP Management Regulation (2024 Edition).

Far Side Pole C-NCAP 2024 (WSID+WSID)

Side Pole C-NCAP 2024 (WSID+ES-2re) • Driver side impact assessing driver injury according to 
Appendix D.

• Injury scoring based on Chapter III section 1.2.1.4 of      
C-NCAP Management Regulation (2024 Edition).

Side Pole C-NCAP 2024 (WSID+WSID)



Energy Check

• Previously, the 

Energy Check tool 

simply plotted total, 

kinetic, internal and 

hourglass energy 

for your model. In 

Oasys 21, the tool 

now plots more 

energies, produces 

visual checks, and 

more.



Entities of Interest

• Previously, the Entities of 

Interest tool was able to 

Only, Highlight and 

complete GLB Exports 

for selected entities 

grouped by Parts or Part 

Sets. In Oasys 21, you 

can now Zoom In, Colour 

By and produce Mixed-

Mode Plots grouped by 

Parts, Parts by Set, Parts 

by Include and Parts by 

Group.

The image shown is an SI Mixed-

Mode Plot on the Footwell and 

Coloured by Magenta on the 

Steering Wheel



Seismic Workflows

Oasys 21 features new tools to power two of the most common seismic analysis workflows:

Storey Drift

In PRIMER, define drift nodes at different 

locations, for each storey.

In T/HIS, storey drifts are plotted for each 

location defined.

Storey Force

In PRIMER, define DATABASE_CROSS_SECTIONs 

for selected structural members grouped into 

SET_PARTs, for each storey.

In T/HIS, storey section forces are extracted for 

the cross-sections defined.

The Workflows can process 

a single model or a sweep 

of LS-DYNA runs for a set 

of ground motions.



Seismic Workflows

You can also generate automated reports with the REPORTER templates provided:



Defined and Undefined Workflows

The Workflows menu has been split into two tabs:

• Defined Workflows – shows workflows that can be run in T/HIS and have the required data  

• Undefined Workflows – shows workflows that could be run in T/HIS, but don’t have the require data



Defined and Undefined Workflows

Selecting a workflow in the 

Undefined Workflows tab will 

open the model in PRIMER and 

start the workflow to select the 

required data. 

In T/HIS, a window will open 

telling you to press Refresh 

when the data has been saved. 

This will update the Workflows 

menu, moving the workflow to 

the Defined Workflows tab so 

it can be run in T/HIS.



Virtual Testing



Virtual Testing

At Oasys Ltd., we are working on software features to support the upcoming Virtual Testing 

Crashworthiness protocols. The first protocols to be introduced are the Euro NCAP Virtual Far 

Side Simulation & Assessment Protocol, and C-NCAP Management Regulation (2024 Edition), with 

others to follow soon.

Oasys 21 contains a set of integrated and complementary Workflow tools to power your Virtual 

Testing CAE workflows:

• Automotive Assessments (now supports the Euro NCAP and C-NCAP virtual testing protocols)

• LS-DYNA to ISO-MME

• SimVT

• VTC Quality Criteria

• VTC Videos

https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://www.c-ncap.org.cn/article-detail/1760235142548373506


Virtual Testing

Virtual Testing presents several challenges for CAE workflows:

Q1. Good correlation is moving from beneficial to mandatory. As CAE teams, we can no longer rely on conservative assumptions. How do we 

ensure that physical tests perform as predicted?

A1. SimVT is a powerful new tool for correlation analysis, providing flexibility, and the ability to interrogate correlation results in detail, to help you 

understand your models’ accuracy, robustness, and sensitivity.

Q2. How do we ensure that the format and quality of information is sufficient when submitting results to Euro NCAP? How to avoid rework and 

resubmission?

A2. Use the VTC Quality Criteria tools to ensure your models meet the required standard. Use the VTC Videos tools to provide the video evidence required. 

Use the LS-DYNA to ISO-MME tool to export your results data in the required format.

Q3. CAE teams will need to work more with physical test data, and safety teams will need to work more with simulation. We will also be dealing 

with more metrics than ever before. How do we improve collaboration and processing?

A3. The LS-DYNA to ISO-MME tool provides seamless transition between simulation and test formats. SimVT supports test data stored in ISO-MME format 

as well as a configurable CSV format.

Q4. How can we manage the large volume of data and processing required for Virtual Testing?

A.4 SimVT helps you summarise the correlation analysis results for all the occupant and structures data channels, as well as providing the ability to sift 

through the data in more detail. Other tools include REPORTER templates to automate the processing of data. Results tables, graphs and scores can be 

exported in various formats to link with your team’s data management tools and processes.



Virtual Testing

• All the new Virtual Testing tools can be 

accessed from the Tools → Workflows 

menus in PRIMER, D3PLOT and T/HIS by 

filtering for Virtual Testing.

• REPORTER templates can be found at

File → Open Library Template… by 

selecting the Automotive tab and filtering 

for Virtual testing. 



LS-DYNA to ISO-MME

• “LS-DYNA to ISO-MME” is a new Workflow tool to convert LS-DYNA results into the ISO-MME format 

specified by the Euro NCAP Virtual Far Side protocol. It can also be used to export the channels required by 

the C-NCAP Far Side Occupant Protection Protocol.

• Automotive Assessments workflow user data removes the need to manually map LS-DYNA entities to ISO-

MME channel codes.

1. In PRIMER, populate all the fields 

required by the Euro NCAP or C-NCAP 

protocol. Contact data and Distance 

between head CoG and excursion lines 

can be populated automatically. When 

you save these, you can reuse the settings 

for subsequent LS-DYNA runs.

2. In T/HIS, perform the export to ISO-MME 

format. Solver and simulation information 

can also be populated automatically.



LS-DYNA to ISO-MME

• The LS-DYNA to ISO-MME Workflow can be automated using the REPORTER template 

provided. The report generated contains a summary of the ISO-MME file information 

and individual channel graphs, as well as highlighting any missing data for correction.



SimVT

• SimVT is a powerful interactive tool for correlating simulation data vs test, or indeed any 

combination of: LS-DYNA models, ISO-MME data or CSV data.

• SimVT supports the Euro NCAP and C-NCAP Virtual Testing protocols and can be used to 

identify sensors that fail to pass Validation Criterion 1 or correlation fitting index 

requirements.

Map LS-DYNA entities to 
test data channels using 
Automotive Assessments

Confirm setup Investigate results

The SimVT Workflow

Correlate Export



SimVT

• SimVT seamlessly aligns simulation curves 

to tests using ISO-MME Channel Codes.

• You can create custom rules for pairing 

approximate matches.

• Hundreds of correlations are achievable 

with a single click.

• Results are displayed in a table and can be 

exported to CSV.

• Graphs of all correlations can be easily 

plotted and navigated.

• Settings files can be saved to restore 

previous sessions.



Euro NCAP Virtual Far Side Validation Criterion 2

• The Euro NCAP Virtual Far Side 2024 VC2 

(Assessment Criteria) REPORTER Template can 

be used to perform the Validation Criterion 2 

(Assessment Criteria) check according to section 

6.3.10 of the Euro NCAP VTC Simulation and 

Assessment Protocol v1.0. 

• Before running the template, you need to set 

up user data in PRIMER’s Automotive 

Assessments Workflow using the Euro NCAP 

‘Far Side + VTC’ protocol.

• You can also perform VC2 manually in T/HIS.



C-NCAP Management Regulation (2024 Edition)

Oasys 21.1 has new support for the various requirements of 

the C-NCAP Far Side Occupant Protection Protocol, including:

• For each of the eight Working Conditions:

• Occupant injury assessment

• ISO Correlation Fitting indices

• Correction Factor A

• Dual-Occupant Penalty calculation

• ISO correlation fitting indices for the Virtual Assessment 

Certificate (prerequisite for the symmetry of far side 

occupant protection airbags)

• Overall score calculation

Read the documentation to learn more

https://help.oasys-software.com/articles/workflows-21-1/cncap-management-regulation-2024-edition


Euro NCAP VTC Quality Criteria

• “Euro NCAP VTC Quality Criteria” is a new, convenient tool for assessing the quality 

criteria specified in section 6.1 of the Euro NCAP Virtual Far Side protocol.

1. In PRIMER, select the model entities 

required for the quality checks, and 

the relevant model and display units. 

Saved user data can be reused for 

subsequent LS-DYNA runs.

2. In T/HIS, the quality checks are 

calculated immediately. Graphs 

illustrate the results of each check. A 

summary table appears, with the 

option to write the results to a CSV 

file.



Euro NCAP VTC Quality Criteria

• The Euro NCAP VTC Quality Criteria Workflow tool can be automated using the REPORTER 

template provided.



C-NCAP VTC Quality Criteria

• The C-NCAP VTC Quality Criteria Workflow tool follows the same principals as the Euro NCAP 

version but assesses the quality criteria specified in section H.1.1(f) of the C-NCAP Far Side 

Simulation & Assessment Protocol.

• The tool can be automated using the REPORTER template provided.



Euro NCAP VTC Videos

• The Euro NCAP VTC Videos Workflow tool helps you calculate the views and export the videos 

specified in section 5.2.1 of the Euro NCAP Virtual Far Side protocol.

• The tool attempts to calculate the 

camera positions automatically 

based on model entities you 

define in PRIMER. You can then 

adjust and save the views in 

D3PLOT to be reused to capture 

the videos for future LS-DYNA 

runs. The whole process can be 

automated using the REPORTER 

template provided.



C-NCAP VTC Videos

• The C-NCAP VTC Videos Workflow tool follows the same principles as the Euro NCAP version 

but helps you calculate the views and export the videos specified in section H.2.8 of the C-NCAP 

Far Side Occupant Protection Protocol (2024 Edition).

• Use the standard Workflow 

method in PRIMER and 

D3PLOT or the whole process 

can be automated using the 

REPORTER template provided.



Miscellaneous



Selection Options for Clipboard

• By default, Find referenced items:

• propagates to junior items e.g. parts > elements;

• finds any latent entities e.g. part > mid;

• finds attached mass.

• New options:

• Propagate to set if item in set (or all items) selected;

• Propagate to senior item to which selected item xrefs

With these options Initial selection 

of Part, selects Set Part which in 

turn selects Contact.

Default selection only gives what 

“belongs” to Part



High order elements – Check and adjust

• Higher order elements are Parabolic and cubic elements, shells and solids with interpolation nodes.

• A model check gives a warning if an interpolation node is not on the straight line joining the 2 corner nodes.

• This is not necessarily wrong (e.g. curved surfaces), but if desired, the nodes can be adjusted to the mid 

point position.

• This can be done using the new Interp. Nodes button available in shell and solid panels:



Support for *CONSTRAINED HyperMesh components

• Added support for processing HyperMesh Components formed of *CONSTRAINEDs 

when reading in a LS-DYNA .key file containing HyperMesh comments (previously 

PRIMER only supported Components formed of *PARTs).

• Now all $HMNAME COMPS, $HWCOLOR COMPS, and $HMCOLOR COMPS comments 

get preserved when read into PRIMER, and all *CONSTRAINED instances get added to 

their corresponding PRIMER groups and assemblies as listed in the $HMASSEM 

comments.



Lock Connections in Mechanism Positioning panel

• You can now Lock or Unlock Multiple 

connections in the list with a single click, via 

the “Lock Connections” popup menu that 

has been added to Lock button:

• All: Locks all the Connections;

• None: Unlocks all the Connections;

• Reverse: Reverses the current Lock/Unlock 

selection for all the Connections.



Parameters

• Parameter edit panel can now be opened from the part tree.

• Parameter names starting with an underscore are now permitted.



Preferences



New Preferences

Preference Description

primer*initial_view_orientation
oasys*initial_view_orientation

Sets the initial view of the graphics window in which PRIMER 
opens (Individual program preference takes precedence)

oasys*workflow_only_use_specified_directory Only scan location set by preference 
oasys*workflow_definitions_directory for Workflow definitions 
(if it is set)

oasys*workflow_user_data_directory Name of a folder to search in for workflow user data

oasys*workflow_max_upward_folder_search_depth Maximum number of folders to search up to look for workflow 
user data

primer*beam_orient_vector_min_angle Minimum angle (radians) between beam axis and orientation 
vector below which it should be flagged as error

primer*allow_bolt_at_hole_convert_to_hexa_weld Allows conversion of bolts on holes to single solid weld

primer*contour_ramp Contour ramp colour option

primer*geometry_highlight_failed_surface_boundaries When TRUE, trim curves of geometry surfaces that failed to 
render are copied to a new model and drawn

primer*geometry_write_tessellation_error_log When TRUE, error messages related to geometry surface 
tessellation are written to a log file in the same directory as the 
parent model



New Preferences

Preference Description

primer*geometry_add_failed_surfaces_to_clipboard When TRUE, surfaces that have failed to render will be added to 
the clipboard

primer*geometry_curve_max_edge_length_factor Max edge length, as a factor of the model diagonal, for 
segments used to draw geometry surface trim curves

primer*geometry_curve_min_edge_length_factor Min edge length, as a factor of the model diagonal, for 
segments used to draw geometry surface trim curves

primer*geometry_surface_max_edge_length_factor Max edge length, as a factor of the model diagonal, of trias 
used to draw geometry surfaces

primer*geometry_surface_min_edge_length_factor Min edge length, as a factor of the model diagonal, of trias used 
to draw geometry surfaces

primer*geometry_element_max_separation_factor Max separation, as a factor of the model diagonal, between the 
centres/edges of trias, used to draw geometry surfaces, and a 
surface

primer*graticule_mode Graticule mode - 2D/3D

primer*label_background Label background display

primer*include_file_exceeds_80_char_warning Message handling when include file exceeding 80 char is read



New Preferences

Preference Description

primer*read_set_collect_include_trans If *SET_COLLECT in *INCLUDE_TRANSFORM with IDSOFF is 
unreferenced remap references

primer*warn_set_collect_include_trans Warn if *SET_COLLECT in *INCLUDE_TRANSFORM with IDSOFF 
non-zero may have errors

primer*permit_duplicate_edit Whether or not to allow a 2nd and subsequent editing panel on 
the same entity

primer*mat_68_write_all_cards As of version 21, MAT_68 optional cards are no longer written, 
set to 'TRUE' for reading MAT_68 into older versions of PRIMER

primer*nastran_read_retain_parabolic_nodes Retain mid-side nodes for parabolic solids and shells

primer*nastran_read_convert_2_noded_RBE2_to_weld ON (def) to convert 2-noded RBE2 to Constrained_Spotweld, 
others to Constrained_NRB. 
OFF to convert all RBE2 to Constrained_NRB

primer*nastran_write_continuation_strings Write continuation strings

primer*nastran_write_merge_overlapping_nrbs Merge overlapping Nodal Rigid Bodies before Nastran write

primer*nastran_write_process_mat169_into_new_parts_by_
thickness

Split adhesive parts into different parts containing solids of 
similar thickness



New Preferences

Preference Description

primer*nastran_write_convert_tied_contact_to_RBE3 Convert DYNA tied contact to RBE3

primer*nastran_write_contact_rbe3_placement RBE3s created from tied contact written to same include as 
element of dependent node, element of independent node, or 
of Dyna contact

primer*nastran_enable_rotational_dof_on_RBE3_shell_nodes Consider rotational d.o.f on RBE3 nodes attached to shells 
(default is translational only)

primer*nastran_write_suppress_rigid_elements Do not write elements when rendering rigid part into Nastran 
use CONM2 instead (unconditional for Part_inertia)

primer*nastran_write_rigid_element_limit If n.gt.0 rigid parts with numel.gt.n will be written using 
reduced RBE2, otherwise all (external) nodes are included

primer*nastran_write_translate_matl_with_uncalc_poisson_
ratio

apply user value for Poisson ratio if it cannot be calculated

primer*nastran_write_poissons_ratio Value of Poisson ratio that will be used for materials with 
undefined Poisson ratio

primer*nastran_write_mat67_with_cbush_stiffness_values MAT67 written using 6 stiffness values as defined on Nastran 
writeout properties panel

primer*nastran_write_cbush_prop_tkr/tks/tkt/rkr/rks/rkt Values of cbush stiffness that will be used while writing 
MAT_67



New Preferences

Preference Description

primer*vis_menu_position Position of the Vis menu - graphics area or docked to parent

primer*orient_constraint_with_node Orient whole constraint when any node is oriented

primer*any_coord_clamp_zero Any nodal coordinates less than this |clamp value| will be set 
to zero during output

primer*trans_coord_clamp_zero Transformed nodal coordinates less than this |clamp value| 
will be set to zero during output

primer*dp_genio_prec_gui General DP values in GUI data fields: number of significant 
figures to use

primer*dp_genio_prec_10/16/20 General DP values in 10, 16, and 20 wide fields. It specifies 
number of significant figures to use

primer*dp_ncio_prec_gui DP coordinate values in GUI button fields: number of significant 
figures to use

primer*dp_ncio_prec_10/16/20 DP coordinate values in 10, 16, and 20 wide fields. It specifies 
number of significant figures to use

primer*tied_rounding How tied values exactly between upper and lower bounds will 
be rounded



New Preferences

Preference Description

primer*script_copy_nonexistent_include_warning Whether to show a warning if a keyword is copied into a non-
existent include

primer*belt_xsec_naming_convention Database Cross-section naming convention

primer*belt_xsec_custom_pre_text Additional pre-text for Database Cross-section e.g. Dummy 1

primer*belt_growth_percent Permitted %age growth of belt element length during fitting

primer*initial_belt_readjust_accept Readjust initial belt points around sliprings after accepting belt 
path

primer*belt_buckle_rot_iter_per_mode Number of iterations per buckle rotation mode

primer*belt_refit_xsec_rename Rename Cross section titles when doing a belt auto-refit

primer*undo_align_elements Turn on/off undo of aligning elements

primer*undo_parameter_change Turn on/off undo of changing parameters while renumbering



New Preferences: PRIMER 21.1

Preference Description

primer*threaded_elem_node_lookup_limit Threshold test time (ms) for element topology lookup to 
consider threading

primer*threaded_elem_node_lookup_yield Permit thread to yield its time slice while waiting

primer*keyout_mutable_at_top Which mutable parameters to write out in the PARAMETER 
block at the top of the file

primer*keyout_mutable_post_include The status of mutable parameters in the parent file after 
reading child INCLUDE file

primer*update_params_on_unused_curves Following a units change whether to change parameterised 
data fields on unreferenced loadcurves

primer*speedup_set_handling_for_node_set_general Speeds up edit create ops for models with many SET_GENERAL



Contact Information

UK

T: +44 121 213 3399

dyna.support@arup.com 

For more information please contact us:

www.arup.com/dyna

China

T: +86 21 3118 8875

china.support@arup.com 
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T: +91 40 69019723 / 98 

india.support@arup.com 

USA West

T: +1 415 940 0959

us.support@arup.com 

or your local Oasys distributor 
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